
LpzRobots and GoRobotos
An installation manual

Frank Hesse, Christoph Rauterberg, Poramate Manoonpong

September 29, 2015

This installation manual shall first provide some general knowledge about
the gorobots-Project and the architecture we use. Then this guide will
explain step-by-step how to set up your Eclipse, so that you can work with
the LpzRobots-Simulation and the gorobots-Project.
In the future, we would like to complete this installation manual in a way,
that it will also include manuals for setting up the software needed for
AMOSII (Hexapod) and other robots.
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1 Introduction

The LpzRobots-Simulation is a robot simulation programmed at the university of
Leipzig. Its main features include the ode robots, which is a 3D robot simulator, that
is physically correct, and the so called selforg, that is a framework for controller im-
plementation.
The important parts of the software architecture are shown in Figure: 1:

ThisSim

Agent

Simulation

AbstractRobot

AbstractController

AbstractWiring

Figure 1: Software Architecture for LpzRobots and GoRobotos

ThisSim will, during a simulation, integrate all elements of this very simulation, which
means controlling the environment, the robot, as well as setting initial parameters and
plotting or logging data.
Agent will integrate all elements of an agent by using the shown classes, one can for
example add sensory preprocessing using a child class of AbstractWiring.
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Simulated Environment: main.cpp

Simulated Robot: amonsII.cpp\h

Real Environment: main.cpp

Real Robot: AMOSII serial.cpp\h

amosIIcontrol.cpp\h

NeuralProcessing.ccp\h

NeuralLocomotion.cpp\h

CPG().cpp\h
POSTCPG().cpp\h

PSN().cpp\h
VRN().cpp\h

Reality

Simulation

Control

Figure 2: Need name for this picture

For working with the LpzRobots-Simulation, you will need a couple of things:

1. A (preferably up-to-date) UNIX-based Operating System (state of the art: Ubuntu
11.10 or Debian 6.0)

2. The Eclipse-Software combined with the following packages:

• C/C++ SDK

• The EGit-Tool-Kit

3. Access to the Assembla-Repository (contact your supervisor for access)

4. The setUpGoRobots.zip file (contact your supervisor for the file)
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2 Setting up Eclipse and LpzRobots

2.1 Running setUpGoRobots.sh

From your supervisor, you will receive the .zip-File setUpGoRobots.zip - or you can
find it at gorobots/docs/install script/. To begin with, you need to extract the files
and the script setUpGoRobots.sh within. This script will:

1. Install the required packages on your computer

2. Include important settings to your .bashrc

3. Fetch the repositories LpzRobots and GoRobots

4. Import the project settings file

5. Compile the files

After extracting, you can run the script, by typing ./setUpGoRobots.sh in the cor-
responding directory. However, you might have to change permission ”chmod u+x
setUpGoRobots.sh” if you cannot execute.

2.1.1 Forking a repository

The script will ask you for the URL of your forked repository. Please read about how
to fork a network with Assembla in Section 4.3.

2.2 Setting up Eclipse

2.2.1 Installing Tool-Kits within Eclipse

Before importing the repositories, you need two tool-kits for your Eclipse:

1. To install a tool-kit, go to Help→Install Software

2. The first tool-kit you need is the C++ Development Kit. Work with the following
link:
http://download.eclipse.org/tools/cdt/releases/indigo

and install the so called CDT-Tool-kits.

3. The second tool-kit is EGIT for accessing GIT within Eclipse. You can download
it working with this link:
http://download.eclipse.org/egit/updates. Whilst doing so, you have to
check the box for Eclipse Git Team Provider and uncheck the box for EGit
Mylyn.
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2.2.2 Importing the Repositories

Once you have finished running the script and have installed the tool-kits, you are
ready to import the repositories into your Eclipse.
To do so, first switch into the Git Repositories - View within Eclipse. You can do
this by clicking: Window→Show View→Other→Git→Git-Repositories and hit OK.
In this view, you can choose Add an existing local GIT repository. The script will
have placed the files at /home/yourlogin/workspace.

2.2.3 Code-Style withing Eclispe

To adapt the Code-Style, go Window→Preferences→C/C++→
Code-Style→Import. Now you choose the file:
workspace/lpzrobots/codeStyleEclipse.xml and hit apply.

2.3 Troubleshooting

If you encounter any problems while using the script, please contact Frank or me
(c.rauterberg@gmx.de) and send us error output, solutions you found, etc. if possible.
Find the install-by-hand-instructions at the end of this manual.
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3 Project Structure

We use, as already mentioned, two GIT repositories, LpzRobots and GoRobots.
Later, the controllers for each robot will be implemented within GoRobots, accessing

the robots, which are located in LpzRobots. The folder DEMO will later contain demos
of the different robots. Another visualisation of the two repositories and where which
file belongs is given in Figure 3.

Figure 3: Structure of the two repositories, LpzRobots and GoRobots

You will later work with your own copy of the two repositories.

LpzRobots and GoRobotos Installation Manual Page 8 of 30



Gorobots

archive (stand alone, inactive)

demos
amosii

adaptive_climbing_control

include

utils
ann­framework
ann­library

controllers
amosIIcontrol.cpp, .h
.ccp, .h

sim

main.cpp

Makefile.conf
makefile

real

main.cpp
Makefile.conf

makefile

climbing_obstacleavoidance_gapavoidance

include
sim
real

dennis
amosii adaptive_climbing_control_ii

include
sim

new finished works (name of developer)

controllers (common components)

amosii
modular_neural_control

amosiicontrol.cpp, .h
BackboneJointControl.cpp, .h
delayline.cpp, .h
new.cpp, .h

reinforcement_learning_control_rbf

nimm4ii
existing.cpp, .h
new.cpp, .h

nejihebi
existing.cpp,.h

new.cpp, .h

projects (active, named by function)

amosii

modular_neural_control
sim

real
koh_preview_neural_control

reinforcement_learning_control_rbf
one goal
multiple goals

adaptive_obstacleavoidance_control

nimm4ii

combinatorial_rc_rc_actor_sim
combinatorial_rc_sim

reinforcement_learning_control_rbf
one goal

multiple goals

nejihebi

practices_solutions

xnor
ploe balancing 2d (ICO learning)

amosii
nimm4ii

utils (general use)

ann­framework

ann­library

esn­framework

dmp­framework

real_robots
sensors

rbf­framework

examples (AI tools, robots)

artificial_neural_networks

ann_controller (amos walking with anns)

backpropagation (batch XOR training
using ann­framework)

hopfield
kohonen
perceptron
esn

evolutionary_algorithms
ga

reinforcement_learning

actor_critic pole_balancing_numerical_sim

q_learning
sarsa

epuck
real

monitor

dmp

practices (AI classes, student homework)

amosii

nimm4ii

xnor (online learning)

pole balancing 2d

docs (manual)
install_manual

install_script

Gorobots.mmap ­ 12/7/2013 ­

Figure 4: Structure of GoRobots. Green parts belong to GoRobotsEdu
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4 Working with GIT

4.1 Overview of GIT-commands

The following picture will give a good overview over the workflow and the commands
in GIT:
The main advantage in GIT is, that every host has got his own local repository, which

Figure 5: An Overview over GIT commands

in itself is an external repository to another host.
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I will give an example, in which I will try, to use most of the commands GIT gives
us:

• You create a new file in your workspace in your own branch, that was not under
version control before

• Now you first have to add it to the index, which for GIT is just a list of files,
that it has to monitor. You can do this using add

• The next step is adding the actual file to the local repository. You can do this
via commit

• Now the file is under version control. You can now could get the file from the
repository using checkout HEAD

• If you also want to add the file to the remote repository, you can use push

• Now another person can get your whole work using pull, which will provide him
with everything, that is currently listed in your remote repository

Please note: Be careful whilst merging, Eclipse will offer you to “overwrite”, which
is not a good idea, as it does exactly what it promisses instead of merging. We will
support this warning with a screenshot if possible! To provide a full overview over the
commands, I will list all the commands, that Eduard did show us in his presentation:

• git add: adds file changes in your workspace to your index

• git commit: Commits all the changes listed in the index to the local repository

• git push: Pushes local branch to the remote repository

• git fetch: Fetches all files from the remote repository, that are not in the local
repository

• git merge: Merges one or more branches into your current branch

• git pull: Fetches files from remote repository and merges them with local files
(equal to git fetch; git merge)

• git rm: Removes a file from your repository
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4.2 Setting up your own branch with GIT

Within your repository, you should still create branches for each feature you develop.
To create a new branch you simple do:

1. In Eclipse, right-click on name of your fork

2. Select Team→Switch to→New Branch

3. As shown in the picture bellow, select the source:
refs/remotes/origin/goettingen master1

4. Choose a name following the scheme yourname yourfeature

5. Activate the checkbox for checking out the new branch

6. Work away

Figure 6: How to create a new branch within Eclipse

1By choosing this, you make sure, that you have the latest online version
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4.3 Forking a Repository

To create a fork of a repository, you need access to the assembla-website. Once you
have logged in, you can choose a repository and then click on the button fork network.
One click on the button fork will then create a fork of the repository for you, as shown
in Figure 7. You will furthermore be asked for a name of this copy of the repository,
remember this name, as you will need it for the setup!

Figure 7: How to fork a repository at the Assembla website

4.4 Merging

Please check with your supervisor, before merging back into master.
If you want to merge a branch of yours, you will have to send a merge request via the
assembla-webpage. A supervisor will then have a look at your code. BUT he is only
able to do so, if you have given him or her the rights to read your code. You can do so
by, on the assembla-webpage in your forked repository, select team and then, on the
right, select Invite people from other teams. No you can choose which one you want
to invite, and then you can choose which rights you want to give him or her.

4.5 How to update your Master Branch

Make sure that you are in your master branch by typing:

˜/ workspace /YOURLOGIN−gorobots−f o rk $ g i t branch

The output should be something like this:
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goplus
f e a tu r e b ranch 1
f ea tu r e b ranch 2
f ea tu r e b ranch 3

∗ master

The star indicates, in which branch you are working right now. If you are not working
in the master-branch, switch to the branch by typing:

˜/ workspace /YOURLOGIN−gorobots−f o rk $ g i t checkout master

You can use git branch again, to check of you are in the right branch now.
If you are in the master branch type

˜/ workspace /YOURLOGIN−gorobots−f o rk$ g i t remote −v

The output should be something like this (if you did not add a remote before):

o r i g i n https : //YOURLOGIN@git . assembla . com/YOURLOGIN−gorobots−f o rk . g i t ( f e t c h )
o r i g i n https : //YOURLOGIN@git . assembla . com/YOURLOGIN−gorobots−f o rk . g i t ( push )

Now you have to add a stable repository as additional remote type:

g i t remote add s t a b l e https : //YOURLOGIN@git . assembla . com/ gorobots . g i t

git remote -v should now show something like:

˜/ workspace /YOURLOGIN−gorobots−f o rk $ g i t remote −v
o r i g i n https : //YOURLOGIN@git . assembla . com/YOURLOGIN−gorobots−f o rk . g i t ( f e t c h )
o r i g i n https : //YOURLOGIN@git . assembla . com/YOURLOGIN−gorobots−f o rk . g i t ( push )
s t a b l e https : //YOURLOGIN@git . assembla . com/ gorobots . g i t ( f e t c h )
s t a b l e https : //YOURLOGIN@git . assembla . com/ gorobots . g i t ( push )

This means you are able to connect to the stable repository (referred to as stable) from
your local repository.
Now update your local repositories information about the stable repository by typing:

˜/ workspace /YOURLOGIN−gorobots−f o rk $ g i t f e t c h s t a b l e

After typing your password you see an output like the following:

From https : // g i t . assembla . com/ gorobots
∗ [ new branch ] master −> s t a b l e / master

Your local repository knows now what branches are available in the stable repository.
Now merge the changes of the stable master in your workspace (which currently con-
tains your local master branch) by typing:

˜/ workspace /YOURLOGIN−gorobots−f o rk $ g i t merge s t a b l e / master

If there were now changes, the Output would be something like:

Already up−to−date .

An example of an output including changes would look like:
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Updating 1054 d9a . . 3 3 0 d652
Fast−forward

docs /README | 6 ++++++
docs / i n s t a l l m a n u a l /README | 5 +++++
docs / i n s t a l l s c r i p t /README | 6 ++++++
3 f i l e s changed , 17 i n s e r t i o n s (+) , 0 d e l e t i o n s (−)
c r e a t e mode 100644 docs /README
c r e a t e mode 100644 docs / i n s t a l l m a n u a l /README
c r e a t e mode 100644 docs / i n s t a l l s c r i p t /README

Now you can use git commit, to commit changes to your local repository, and git push,
to commit changes to the remote repository.
Now your master branch is up to date with our stable version and you can continue
with the next section.
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5 Installing LpzRobots by Hand

Before you install LpzRobots, you first need to install a couple of additional packages.
You can do this using the following commands:
sudo apt-get install\
g++ make automake libtool xutils-dev m4 libreadline-dev libgsl0-dev\
libglu-dev libgl1-mesa-dev freeglut3-dev libopenscenegraph-dev\
libqt4-dev libqt4-opengl libqt4-opengl-dev qt4-qmake libqt4-qt3support gnuplot2

Also, you will need this package:
sudo apt-get install binutils-gold3

Furthermore, you will need to add some lines to your .bashrc:

# definitions for lpzrobots
export CPATH=”$HOME/include”
export LIBRARY PATH=”$HOME/lib”
export LD LIBRARY PATH=${LD LIBRARY PATH}:$HOME/lib:/usr/lib/osgPlugins2.8.1
export PATH=${PATH}:$HOME/bin

Now you are ready to install the LpzRobot-Simulation.
As Eclipse has now synchronized its workspace with the GIT-Repository, you can find the
setup-files in your workspace.
To install LpzRobots, go to workspace→lpzrobots and run make (all).
Install it to /home/YOURLOGIN and choose install as developer,
which is the shortcut d

2You can also find this list of dependencies in the repository lpzrobots
3You may need this only for newer Ubuntu-Versions (>= 11.10), as the linker does not link anymore
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6 Using the Google Test Framework for Unit Testing

We are trying to maintain our code with the help of a unit testing framework, namely
googletest.

6.1 Installing the framework

To be able to use this feature and develop new test cases, you first have to install the googletest
framework. Here are the necessary steps:

Start by downloading the source code of the most recent googletest version. It is available
under https://code.google.com/p/googletest/downloads. Decompress the archive and
enter it in a terminal:

$ cd gte s t −1.7 .0

Inside the decompressed folder, create a new directory called “build” and enter it:

$ mkdir bu i ld
$ cd bu i ld

Use cmake to create a Makefile and use this Makefile to build googletest:

$ cmake . .
$ make

You’ll find a libgtest.a and libgtest main.a file inside the build directory. Copy these files to
some path that is registered in the LD LIBRARY PATH environment variable. Typically,
during the installation of lpzrobots, you add the lib folder in your home directory to the
LD LIBRARY PATH. To copy the files there, type:

$ cp l i b g t e s t . a l i b g t e s t m a i n . a ˜/ l i b

Furthermore, you have to copy the folder gtest inside the include directory located in the
googletest root folder to some path that you include into the search path while compiling
gorobots simulations. You can use the include folder created during the lpzrobots installation
(typically in your home folder). Starting in the build directory, type the following:

$ cd . . / i n c lude
$ cp −r g t e s t ˜/ inc lude /

This finishes the installation of the googletest framework. You may now enter the gorobots
folder and build the test cases:

$ cd ˜/ workspace / gorobots
$ make t e s t

You should also try to run the tests:

$ . / bu i ld / r u n t e s t
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6.2 Creating test cases

There is a nice tutorial about the basic ideas and concepts of the googletest framework at
the webpage of the project. You should definitely read it before going on: https://code.

google.com/p/googletest/wiki/V1_7_Primer

Within the gorobots project, we want to use the googletest framework for real unit testing
as well as for something that is more like integration testing. Unit testing refers to the testing
of as small as possible subunits of code. For instance, there is a test for the ann-framework
that checks whether the activity property of the Neuron class works as expected:

TEST( NeuronTest , a c t i v i t y ) {
Neuron neuron ;
neuron . s e t A c t i v i t y ( 1 . 2 ) ;
ASSERT EQ( 1 . 2 , neuron . g e t A c t i v i t y ( ) ) ;

}

This is as primitive as it can get. Observe that “NeuronTest” is the name of the test case
and “activity” the name of the actual test. You should make sure your test case names are
unique within gorobots.

For creating a test for a given unit of code, create a new file in the “tests” folder within
the gorobots repository. The path of the file within the tests folder should resemble the path
of the tested unit in the gorobots repository. Furthermore, the name of the test file should
be the name of the unit plus “ test”. If, for instance, the files containing the actual code are

u t i l s /ann framework/neuron . h
u t i l s /ann framework/neuron . cpp

the correct path and name of the corresponding test file is

t e s t s / u t i l s /ann framework/ neuron t e s t . cpp

Within your new test file, you have to include the header of the googletest framework and
the headers necessary to perform your tests. For instance:

#inc lude ” g t e s t / g t e s t . h”
#inc lude ” u t i l s /ann−framework/neuron . h”

Afterwards, just start to define your tests.
When it comes to testing of projects, thins get a little more trickier. This is due to our

standard of defining the simulation class within the main.cpp. Unfortunately, every main.cpp
typically also contains one main method and we cant’t link multiple objects that contain
methods with the same name. The solution for this is a little hackish: Before including the
main.cpp, which is necessary here, add two define statements to override the name of the
main method and the ThisSim class. The latter is neccessary to avoid identically named
classes in different object files. The results might look like this:

#inc lude ” g t e s t / g t e s t . h”

// mask names o f o b j e c t s in g l o b a l scope
#d e f i n e main p r o j e c t s n e j i h e b i e x a m p l e m a i n
#d e f i n e ThisSim ProjectNejihebiExampleMainSim

#inc lude ” p r o j e c t s / n e j i h e b i /example/sim/main . cpp”
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Within the actual test of your project, you should run your simulation for an as short as
possible time interval and check afterwards whether the relevant parameters of the robot have
the expected values. This might require too add some additional methods to the ThisSim
class. Check out the test of the Nejihebi example project to get an idea how this might look
like:

t e s t s / p r o j e c t s / n e j i h e b i e x a m p l e t e s t . cpp
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7 Additional (real) Hardware: Camera and Laserscanner

7.1 Step by step to install: Camera, LpzRobots and Eclipse, Laser
scanner

1) Linux: Install Linux e.g., Ubuntu 12.04
2) Camera: Install OpenCV and AprilTag for Camera (see How to Use Camera.pdf) OR
follow the steps below

1. Use Synaptic Package Manager to install (OpenCV): libopencv-dev

2. Install necessary packages of AprilTag:

See http :// a p r i l . e e c s . umich . edu/ wik i / index . php/ Download and Ins ta l l a t i on

OR

sudo apt−get i n s t a l l emacs g i t−core ant subver s i on gtk−doc−t o o l s
l i b g l i b 2 .0−dev l ibusb −1.0−0−dev gv l i b n c u r s e s−dev openjdk−6−jdk
autopoint l i b g l 1−mesa−dev

3. Install LCM of AprilTag:

cd $HOME
svn checkout http :// lcm . goog lecode . com/svn/ trunk lcm
cd lcm
. / boots t rap . sh
. / c o n f i g u r e
make
sudo make i n s t a l l

4. Install libdc1394of AprilTag:

cd $HOME
svn co https : // l ibdc1394 . svn . s o u r c e f o r g e . net / svnroot / l ibdc1394 / trunk / l ibdc1394 /
cd l ibdc1394
autorecon f − i −s
. / c o n f i g u r e
make
sudo make i n s t a l l

OR

Note that I met with a problem when I i n s t a l l l i bdc1394 .
So , another way to do t h i s i s :
At te rmina l : apt i tude search l ibdc1394
then you can see s e v e r a l f i l e s the re .
Choose l ibdc1394 −22 and l ibdc1394−22−dev to i n s t a l l , l i k e :
sudo apt i tude i n s t a l l l ibdc1394 −22
sudo apt i tude i n s t a l l l ibdc1394−22−dev
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5. Set up environment variables of AprilTag by adding the following lines to .bashrc

export CLASSPATH=$CLASSPATH: / usr / share / java / gluegen−r t . j a r : / usr /
l o c a l / share / java /lcm . j a r :$HOME/ a p r i l / java / a p r i l . j a r : . /
export LD LIBRARY PATH=$LD LIBRARY PATH:$HOME/ a p r i l / l i b
a l i a s java =’ java −ea −se rver ’

6. Then reload your bash settings (you won’t need to do this the next time you log in):

source ˜/ . bashrc

7. Install April Toolkit:

cd $HOME
g i t c l one g i t : // a p r i l . e e c s . umich . edu/home/ g i t / a p r i l . g i t
cd a p r i l / java
ant

8. Test AprilTag − > You can test the 3D visualization environment with:

java a p r i l . v i s . VisTest

Or try out the camera a c q u i s i t i o n so f tware with :

java a p r i l . jcam . JCamView

Or try to run camera t e s t program at :
\camera\ToSte f fen
Make sure that ”cvCaptureFromCAM(−1) or cvCaptureFromCAM (0)”
in t e s t c l i e n t . cpp

Terminal 1 :
java j s e r v e r t e s t

Terminal 2 :
make c l ean
make
. / t e s t c l i e n t

3) Lpzrobots and Eclipse (see Setting up Eclipse and LpzRobots section)

I f you want to use Laser scanner then make sure that in
. / setUpGoRobots . sh

These ones are not i n s t a l l e d :
#echo ”sudo apt−get i n s t a l l b i n u t i l s−gold ”
#sudo apt−get i n s t a l l b i n u t i l s−gold

>After f i n i s h t h i s :
>Star t : Ec l i p s e s>>S e l e c t : Help>I n s t a l l Software

1 . Work with : http :// download . e c l i p s e . org / t o o l s / cdt / r e l e a s e s / ind igo
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S e l e c t : C/C++ Development Tools

2 . Work with : http :// download . e c l i p s e . org / e g i t / updates
S e l e c t : E c l i p s e EGIT

Due to Ubuntu 12 .04 , you need to type sudo make a l l
then you might get the e r r o r messages :

make [ 2 ] : Leaving d i r e c t o r y ‘/home/poramate/ workspace /pmanoonpong−l pz robot s−fork ’
sudo make i n s t a l l o d e r o b o t s
[ sudo ] password f o r poramate :

> . / s t a r t
> . / s t a r t : e r r o r whi l e l oad ing shared l i b r a r i e s : l i b o d e \ db l . so . 1 :

cannot open shared ob j e c t f i l e : No such f i l e or d i r e c t o r y

The s o l u t i o n was :
When i n s t a l l i n g Lpzrobots make sure that you i n s t a l l i t in
/home/ your log in , e . g . , /home/poramate

I f you made t h i s mistake , you could change t h i s by :
From terminal , go to your lpzrobot s ,
e . g . poramate@ubuntu :˜/ workspace /pmanoonpong−l pz robot s−f o rk$

make c l ean
make clean−a l l
make conf

Then : s e t new i n s t a l l i n g path : /home/ your log in , e . g . , /home/poramate

make a l l

4) Laser scanner

u t i l i t i e s /urg
1) sudo apt−get i n s t a l l l i b s d l−net1 . 2
2) sudo apt−get i n s t a l l l i b s d l−net1 .2−dev
3) sudo apt−get i n s t a l l l i b s d l 1 .2−dev

4) sudo sh c o n f i g u r e
5) sudo make
6) sudo make i n s t a l l

poramate@ubuntu :˜/ Documents/ u t i l i t i e s /urg

Go to example :
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poramate@ubuntu :˜/ Documents/ u t i l i t i e s /urg / samples /cpp

Running program :

UrgDevice : : connect : /dev/ttyACM0 : No such f i l e or d i r e c t o r y
poramate@ubuntu :˜/ Documents/ u t i l i t i e s /urg / samples /cpp : sudo . / mdScan
UrgDevice : : connect : /dev/ttyACM0 : No such f i l e or d i r e c t o r y
poramate@ubuntu :˜/ Documents/ u t i l i t i e s /urg / samples /cpp :

7.2 Starting Laser scanner demo with simulated and real robots

1) Check out ” p r e v i e w l a s e r s c a n n e r ” branch from Lpzrobots r e p o s i t o r y
2) in the Lpzrobot d i r e c t o r y : e . g . , ˜/ worskspace / yourname−l pz robot s−f o r k s : make conf ,
s e l e c t opt ion = 1 f o r us ing l a s e r s canne r ,
s e l e c t opt ion = 0 f o r not us ing l a s e r s canne r ,
3) then make a l l
4) go to ˜/ worskspace / yourname−l pz robot s−f o r k s / oderobots /
s imu la t i on s / t e m p l a t e l a s e r s c a n n e r
5) type make and then . / s t a r t
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8 ROS installation

8.1 Step by step

ROS i s r equ i r ed i f you want to read the EEG s i g n a l from s i n g l e dry e l e c t r o d e
( s ee Stoya ’ master t h e s i s , SDU) to the Lpzrobots
For example , s e e >> pro j e c t s>> amosi>> e e g b a s e d c o n t r o l

Step1 : check http :// wik i . r o s . org / ind igo / I n s t a l l a t i o n /Ubuntu

Step2 : Conf igure your Ubuntu r e p o s i t o r i e s
Conf igure your Ubuntu r e p o s i t o r i e s to a l low ” r e s t r i c t e d , ” ” universe , ” and ” mul t i v e r s e . ”
You can f o l l o w the Ubuntu guide f o r i n s t r u c t i o n s on doing t h i s .
( see , https : // help . ubuntu . com/community/ R e p o s i t o r i e s /Ubuntu )

Step3 : sudo sh −c ’ echo ”deb http :// packages . ro s . org / ros /
ubuntu $ ( l s b r e l e a s e −sc ) main” > / e t c / apt / sourc e s . l i s t . d/ ros−l a t e s t . l i s t ’

Step4 : wget https : // raw . g i thubuse rcontent . com/ ros /
r o s d i s t r o / master / ros . key −O − | sudo apt−key add −

Step5 : sudo apt−get update

Step6 : sudo apt−get i n s t a l l ros−ind igo−desktop− f u l l

Step7 : sudo rosdep i n i t

Step8 : rosdep update

Step9 : echo ” source / opt/ ros / ind igo / setup . bash” >> ˜/ . bashrc

Step10 : source ˜/ . bashrc

Step11 : sudo apt−get i n s t a l l python−r o s i n s t a l l

>> Star t ROS by type > r o s c o r e

>> Adding ROS in to Lpzrobots
s ee MakeFile . conf in >> pro j e c t s>> amosi>> e eg ba s ed cont ro l>>sim

pkg−c o n f i g −−c f l a g s roscpp

>> Then add t h i s i n to your makeFile . conf
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−I / opt/ ros / ind igo / inc lude

#ROS > Run : pkg−c o n f i g −−c f l a g s roscpp

# This w i l l g ive you the INC path , e . g . , −I / opt/ ros / ind igo / inc lude
see p ro j e c t s>amosi>e eg ba s ed cont ro l> f i l t e r i n g c l a s s i f i c a t i o n > MakeFile . conf

Add t h i s in the MakeFile . conf
s ee MakeFile . conf in >> pro j e c t s>> amosi>> e eg ba s ed cont ro l>>sim
see MakeFile . conf in >> pro j e c t s>>amosi>>e eg ba s ed cont ro l>> f i l t e r i n g c l a s s i f i c a t i o n

INC += −I / opt/ ros / ind igo / inc lude

#ROS > Run : pkg−c o n f i g −− l i b s roscpp
# This w i l l g ive you the LIBS path
Add t h i s in the MakeFile . conf ,
s e e MakeFile . conf in >> pro j e c t s>> amosi>> e eg ba s ed cont ro l>>sim
see MakeFile . conf in >> pro j e c t s>>amosi>>e eg ba s ed cont ro l>> f i l t e r i n g c l a s s i f i c a t i o n

LIBS += −L/opt / ros / ind igo / l i b −l r o s cpp −l p thread
− l : / usr / l i b / x86 64−l inux−gnu/ l i b b o o s t s i g n a l s . so − l :
/ usr / l i b / x86 64−l inux−gnu/ l i b b o o s t f i l e s y s t e m . so
− l r o s c o n s o l e − l r o s c o n s o l e l o g 4 c x x
− l r o s c o n s o l e b a c k e n d i n t e r f a c e − l : / usr / l i b / l i b l o g 4 c x x . so
− l : / usr / l i b / x86 64−l inux−gnu/ l i b b o o s t r e g e x . so
−lxmlrpcpp − l r o s c p p s e r i a l i z a t i o n − l r o s t i m e
− l : / usr / l i b / x86 64−l inux−gnu/ l i b b o o s t d a t e t i m e . so −lcpp common
− l : / usr / l i b / x86 64−l inux−gnu/ l i bboo s t sy s t em . so
− l : / usr / l i b / x86 64−l inux−gnu/ l i b b o o s t t h r e a d . so
− l : / usr / l i b / x86 64−l inux−gnu/ l i bp th r ead . so
− l : / usr / l i b / x86 64−l inux−gnu/ l i b c o n s o l e b r i d g e . so
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9 FAQs

9.1 Installation errors in general

9.1.1 Symbol lookup error

After installing the ”binutils-gold” package, I get the following error after recompiling my
source code: ”./test: symbol lookup error: /usr/local/lib/liburg.so.0: undefined symbol:
ZTIN3qrk10CoordinateE” (Note: liburg is a library for the Hokuyo laser scanners from here

or via packet manager).

As ”binutils-gold” contains a different linker for C++ files, which is optimized for speed,
it is likely that this new linker does not link the laser scanner libraries correctly (probably
due to ”bad” programming within the drivers). However, this new linker is not necessary for
compiling and running lpzrobots, it just speeds up the compilation time. So the solution to
the problem is simple: Uninstall ”binutils-gold” and everything works.

9.2 Problem of displaying plots from Guilogger

If you cannot display any plots from Guilogger:

You need to i n s t a l l gnuplot−x11
”sudo apt−get i n s t a l l gnuplot−x11”

9.3 Cannot complie Lpzrobots

I f you cannot compl ie Lpzrobots , you may check in . bashrc \\
You should have ‘ ‘ export PATH = /home/YOUR USER NAME/ bin :$PATH’ ’

e . g . , you should have a l l the se in your . bashrc

# d e f i n i t i o n s f o r l p z r o b o t s
export CPATH= ‘ ‘$HOME/ inc lude ’ ’
export LIBRARY PATH= ‘ ‘$HOME/ l i b ’ ’
export LD LIBRARY PATH=${LD LIBRARY PATH} :$HOME/ l i b : / usr / l i b / osgPlug ins3 . 0 . 1
export PATH=${PATH} :$HOME/ bin
export PATH = /home/poma/ bin :$PATH

9.4 Errors using setUpGoRotobots.sh

9.4.1 Fail to run setUpGoRotobots.sh

You might have to change permis s ion ‘ ‘ chmod u+x setUpGoRobots . sh ’ ’
i f you cannot execute .

You should a l s o t ry to update your system .
>> sudo apt−get update
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I f you f a i l to c l one us ing the s c r i p t , you could
c lone d i r e c t l y as below ( otherwise , sk ip t h i s )

>>/workspace$ g i t c l one https : // your user name@git . assembla . com/
your user name−gorobots−f o rk . g i t −b master

>>/workspace$ g i t c l one https : // your user name@git . assembla . com/
your user name−l pz robot s−f o rk . g i t −b l p z r o b o t s

9.4.2 Error with git clone

Whilst cloning the repositories, I encountered the following error:

g i t c l one https : // crauterb@git . assembla . com/ l p z r o b o t s . g i t −b master
Cloning in to crauterb−l pz robot s−f o rk . . .
Password :
remote : Counting o b j e c t s : 25478 , done .
remote : Compressing o b j e c t s : 100% (6030/6030) , done .
remote : Total 25478 ( de l t a 19211) , reused 25478 ( d e l t a 19211)
Rece iv ing o b j e c t s : 100% (25478/25478) , 19 .97 MiB | 527 KiB/s , done .
Reso lv ing d e l t a s : 100% (19211/19211) , done .
warning : Remote branch master not found in upstream or i g i n , us ing HEAD ins t ead
warning : remote HEAD r e f e r s to nonex i s t ent r e f , unable to checkout .

the repository Lpzrobots when there was no branch master, and for some reason, it was
not added later and did not appear anywear. The solution was simple: Delete the forked
version and create a new one - if possible. Worked for me.

9.5 Problems with GIT

9.5.1 Setting up Repositories in Eclipse

In some cases, the instructions on how to set up the GIT-repositories within Eclipse did not
work.
Here is a different approach, that worked for me:

1. Import the repositories into the GIT-view of Eclipse, just as described before

2. Instead of importing over the GIT-View, you now go onto File → Import → General
→ Existing Projects into Workspace and you then choose the two repositories

3. After Eclipse has imported the files, you can right-click on the Project, and then select
Team → Share

4. Now, just select GIT and the two GIT-repository-adresses should appear

5. Apply

9.5.2 No Connection to GIT Server: The remote end hung up unexpectedly.

If you defined stable as usual (check withgit remote -v):
stable https://wbj@git.assembla.com/lpzrobots.git(fetch)

LpzRobots and GoRobotos Installation Manual Page 27 of 30



stable https://wbj@git.assembla.com/lpzrobots.git(push)

but when typing git fetch origin you get the following error message:
Password for ’https://wbj@git.assembla.com’:

error: RPC failed; result=22, HTTP code = 401

fatal: The remote end hung up unexpectedly

and also defining the origin with http only:
stable_http http://wbj@git.assembla.com/lpzrobots.git(fetch)

does not help, try to use the git protocol:
stable_git2 git@git.assembla.com:lpzrobots.git(fetch)

stable_git2 git@git.assembla.com:lpzrobots.git(push)

9.6 Compile Errors

9.6.1 OpenCV highgui missing

You are using gorobots as a library build (“new makefile system”) and you are experiencing
the following error while trying to compile, you are missing the highgui library development
files of the opencv package:

u t i l s / r e a l r o b o t s / s e n s o r s /camera/CamTagPositionSensor . h : 1 1 : 3 9 :
f a t a l e r r o r : opencv2/ h ighgu i / h ighgu i . hpp : No such f i l e or d i r e c t o r y

Install the missing package by typing:

$ sudo apt−get i n s t a l l l ibopencv−highgui−dev

9.6.2 C++11 unknown

If you are trying to compile and obtain errors related to the flag

−std=c++11

it means that you finally will have to upgrade your machine as your version of gcc does not
support the C++11 flag.

9.6.3 osg::Geometry::BIND PER PRIMITIVE unknown

If your version of Open Scene Graph it too recent, you may observe the following error while
trying to compile lpzrobots:

osg / o s g p r i m i t i v e . cpp : 6 6 8 : 3 2 : e r r o r :
’BIND PER PRIMITIVE ’ i s not a member o f ’ osg : : Geometry ’

One quick fix for this is to just comment out line 668 in osgosgprimitive.cpp. Updating to a
more recent version of lpzrobots would resolve the problem as well.

9.6.4 cannot find -ltinyxml2

With the recent version of gorobots where unit test is embedded, you might have this problem
after “make” in gorobots:
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/ usr / bin / ld : cannot f i n d −l t inyxml2
c o l l e c t 2 : e r r o r : ld returned 1 e x i t s t a t u s
make : ∗∗∗ [ l i b g o r o b o t s . so ] Error 1

You need to install -ltinyxml2. For installation, you could use synaptics and search for
tinyxml2 and then select ”libtinyxml2-dev and litinyxml2-0.0.0”.

9.7 Errors when starting the simulation

The error messages was:

> . / s t a r t
> . / s t a r t : e r r o r whi l e l oad ing shared l i b r a r i e s : l i b o d e \ db l . so . 1 :

cannot open shared ob j e c t f i l e : No such f i l e or d i r e c t o r y

B a s i c a l l y when you compile lpz−robot to some l o c a l d i r e c t o r y .
The p r o j e c t s cannot s t a r t as they cannot l o c a t e ” l i b o d e d b l . so . 1”
A quick f i x i n v o l v e s making a symbol ic l i n k ( with root p r i v i l e d g e )
that po in t s to the f i l e in your systems / l i b / l i b r a r y .

The solution was:

> source ˜/ . bashrc

Another s o l u t i o n was :

” sudo ln −s f home/username/ l p z r o b o t s
/opende/ode/ s r c / . l i b s / l i b o d e d b l . so . 1 / l i b / l i b o d e d b l . so . 1”

i f you use Ubuntu v e r s i o n 12 .4 LTS, you might see t h i s problem :

> . / s t a r t
> . / s t a r t : symbol lookup e r r o r : / usr / l i b / l i b g s l . so . 0 : undef ined symbol : cblas dnrm2

The solution was:

> sudo apt−get remove b i n u t i l s−gold

9.8 Using Lpzrobots

> a f t e r s t a r t s imu la t i on , p r e s s 1 to f i x e d camera view
> Ctr l r = record movie
> .\ s t a r t −f = record log f i l e
> .\ s t a r t = s t a r t program
> .\ s t a r t −g 1 = d i sp l a y GUI

9.9 Using EPuck Monitor

9.9.1 When trying to run qmake, I obtain “unknown QT: widgets”

EPuck monitor is optimized for Qt5. If you obtain the “unknown QT: widgets” warning you
are most likely using Qt4 by default on your system. Find out how to enable Qt5 by default
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on your system. If you are working with Ubuntu 12.04 LTS, the following terminal commands
are what you are looking for. They will install Qt5 and enable it as default:

$ sudo apt−add−r e p o s i t o r y ppa : ubuntu−sdk−team/ppa
$ sudo apt−get update
$ sudo apt−get i n s t a l l q t d e c l a r a t i v e 5−dev qt5−d e f a u l t

9.10 Serial interface

> sudo usermod −a −G d i a l o u t username
> Then r e s t a r t your PC

9.11 Public key to push to assembla

For the f i r s t time to push from your PC to assembla , you need to

1) Generate and upload your SSH key

ssh−keygen −t r sa −C ”your emai l ”

2) Copy pub l i c key ( i d r s a . pub ) in to your Assembla P r o f i l e :
https : //www. assembla . com/ user / e d i t / e d i t g i t s e t t i n g s

Please a l s o check i n s t r u c t i o n s on assembla :

https : //www. assembla . com/ spaces / dshaikh−gorobots−f o rk / g i t / i n s t r u c t i o n s
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